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Abstract

We present a method of analyzing sphingomyelin (SM) qualitatively and quantitatively by liquid chromatography-electrospray Ionization-tandem
mass spectrometry (LC-ESI-MS/MS). SM is a common sphingolipid composed of a phosphorylcholine and a ceramide as the hydrophilic and
hydrophobic component, respectively. A number of SM species are present in mammalian cells due to a variety in the sphingoid long chain base
(LCB) and an N-acyl moiety in the ceramide. In this report, we show a method of estimating the number of carbon and double bonds in a LCB
and an N-acyl moiety based on their corresponding product ions in MS/MS/MS (MS3) experiments. In addition, we present a quantitative analysis
method for SM using two stable isotopically labeled SM species, which facilitates determining the range used in SM quantitation. The present
method will be useful in characterizing a variety of SM species in biological samples and industrial products such as cosmetics.

Video Link

The video component of this article can be found at https://www.jove.com/video/57293/

Introduction

Sphingomyelin (SM) is a common sphingolipid in mammalian cells. SM is synthesized intracellularly1 and present as a precursor for other
sphingolipids such as a sphingosine-1-phosphate and a ceramide, which have crucial roles in immune cell trafficking and skin barrier
homeostasis, respectively2,3. Thus, the precise analysis of the SM metabolism is important for elucidating the physiological and pathological roles
of sphingolipids.

SM is composed of a ceramide and a phosphorylcholine that is linked to the 1-hydroxy group of the ceramide, which is further composed of a
sphingosine and an N-acyl moiety. A variety in the carbon and double bond numbers in both the sphingosine and N-acyl moiety results in the
number of ceramide (and SM) species. Recent advances in LC-ESI-MS/MS has enabled quantitative and qualitative analysis of SM4,5. In the
qualitative analysis, the number of carbon and double bonds of a sphingoid LCB of SM was identified by assigning product ion spectra of LCB.
However, structural information of the N-acyl moiety was not directly obtained because its corresponding product ions have not been reported,
and therefore N-acyl moieties were deduced by differential analysis between precursor ions and product ions corresponding to LCB in both
positive and negative ion modes4,5. In this report, we present a method to detect the product ions of both LCB and N-acyl moiety simultaneously
in MS3 mode using triple quadrupole and quadrupole linear ion trap mass spectrometry, which facilitates the precise structural speculation of
each SM species6.

The ion suppression (or enhancement) effects caused by the matrix in biological samples hamper the accurate quantification in LC-ESI-
MS analysis, and therefore, it is desirable to construct calibration curves for all analytes of interest in the identical matrix of the biological
sample. However, this strategy is not feasible because it is almost impossible to prepare all SM species in biological samples, especially in
comprehensive analysis. Thus, it is practical to construct a calibration curve and determine the quantitative range using a representative SM
species spiked in the biological samples. We used two isotopically-labeled SM species to construct a calibration curve; one was used for
an internal standard and the other for a standard compound. We detected a small amount of isotopically-labeled SM species as a standard
compound spiked in biological samples and successfully obtained a calibration curve and the quantitative range6.

Protocol

Consult all relevant material safety data sheets (MSDS) before use. Wear gloves to minimize sample contamination by skin-derived SM. The
present protocol was applied to HeLa cells grown in Eagle's minimum essential medium supplemented with 10% fetal bovine serum (FBS), 2 mM
L-glutamine, 1,000 U/L penicillin, and 100 mg/L streptomycin.
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1. Preparation of Lipid Samples

NOTE: It is important that all glassware including test tubes with Teflon-lined screw caps be detergent-free.

1. Extraction of total lipid fraction from cell homogenate using the Bligh & Dyer method7

1. Remove the culture (or conditioned) media from the 10-cm tissue culture dish and rinse twice with 6 mL of ice-cold PBS.
2. Add 1 mL of ice-cold PBS into the 10-cm tissue culture dish by P1000 pipette. Harvest the cells with cell scrapers and collect into 2.0-

mL siliconized plastic tubes.
3. After centrifugation (1,000 × g, 5 min, 4 °C), remove the supernatant by a P1000 pipette.
4. Add 1 mL of methanol. Vortex tubes briefly and sonicate at 200 W for 5 min in a bath-type sonicator.

 

NOTE: Adjust the water level in a bath-type sonicator so that the cell pellet is efficiently homogenized.
5. Transfer the cell homogenate in methanol by pipette into test tubes (13 mm x 100 mm) with Teflon-lined screw caps.
6. Add 1 mL of methanol, 1 mL of chloroform, 0.8 mL of double distilled water, and 50 µL of 10 µmol/L of internal standard d18:1/

(D31)-16:0 SM into each test tube.
7. Vortex test tubes vigorously for 5 min at room temperature.

 

NOTE: At this point, a single phase (chloroform/methanol/water = 1/2/0.8 (v/v/v)) is formed.
8. Add 1 mL of chloroform and 1.0 mL of double distilled water.
9. Vortex tubes vigorously at 2,500 rpm for 5 min at room temperature.

 

NOTE: At this point, the aqueous (upper) phase and organic (lower) phase are separated.
10. After centrifugation (2,150 × g, 5 min, 25 °C), collect and transfer the lower phase into disposable glass tubes (initial lower phase).

 

NOTE: Collect the lower phase using a Pasteur pipette and a safety pipette filter. Insert the tip of the pipette into the lower phase,
squeeze the small bulb next to the 'E' valve to deliver the upper phase and interfacial fluff inside the tip of the pipette, and then siphon
the lower phase into the pipette.

11. Add 2 mL of chloroform into the test tubes, and vortex the tubes vigorously at 2,500 rpm for 5 min at room temperature to sufficiently
mix with the upper phase and interfacial fluff.

12. After centrifugation (2,150 × g, 5 min, 25 °C), collect and transfer the modified lower phase into the disposable glass tubes with the
initial lower phase as described in step 1.1.10.

13. Place the glass tubes under a nitrogen stream and completely remove the organic solvents in the collected lower phase.
14. Reconstitute the samples with 500 µL of methanol or ethanol, filtrate with a 0.02-µm filter, and store in glass vials at -20 °C.

2. Sample preparation for constructing the calibration curve and validating the method
1. Add 50 µL of 0.1, 0.5, 1, 5, 10, or 50 µmol/L of standard compound (d18:1/(D9)-18:1 SM) into test tubes with Teflon-lined screw caps.
2. Add cell homogenate into each test tube and add methanol to 1 mL.

 

NOTE: The amount of cell homogenate as a matrix varies according to each experiment. If the SM species in samples derived from
cells in a 10-cm culture dish are routinely analyzed, the amount of cell homogenate in each test tube should be close to that of cells in
a 10-cm culture dish.

3. Extract the total lipid fraction as described in steps 1.1.6-1.1.14.
4. Prepare quality check (QC) samples for validating the method as descried in steps 1.2.1-1.2.3. Prepare three QC samples with

different concentrations of standard compound (d18:1/(D9)-18:1 SM): one within 3x the lower boundary of the standard curve (QC-low,
QC-L), one near the center (QC-middle, QC-M), and one near the upper boundary of the standard curve (QC-high, QC-H).

2. SM Analysis by LC-ESI-MS/MS

1. Preparation of the mobile phase
1. Mix the solvents (acetonitrile/methanol/ddH2O = 2/2/1 (v/v/v) for the aqueous phase and isopropanol for the organic phase) in glass

bottles with Teflon-lined screw caps and sonicate for 5 min in a bath-type sonicator.
2. Add formic acid (final concentration 26.4 mmol/L) and NH4OH (14.9 mmol/L) into each mobile phase.

2. Qualitative analysis of SM by LC-ESI-MS3

1. Activate the high performance liquid chromatography (HPLC) system, put inlet tubes into the glass bottles that contain mobile phases,
and purge the HPLC lines. Link a C18 HPLC column (1.5 mm i.d. × 100 mm length, particle size 3.0 µm) to the HPLC system, keep the
temperature in the column oven at 50 °C, and condition the column with the aqueous mobile phase at 100 µL/min. Put the samples into
a sample rack in the autosampler.

2. Set the parameters of the triple quadrupole and quadrupole linear ion trap mass spectrometry system for MS3 analysis as listed in
Table 1 and Table 2 as well as the first and second precursor ions of the SM species of interest.

1. Double click the software icon for data acquisition, double click the 'Hardware Configuration', select 'LC+QTRAP4500+Valve',
and click 'Activate Profile'.

2. Create a new subfolder by clicking 'New Sub-Project' and 'OK'.
3. Click the 'file' tab, select 'New', and select 'Acquisition Method' and 'OK'. Click the 'Mass Spec' icon and 'MS' tab. Select Scan

type as 'MS/MS/MS (MS3)', Scan rate as 10,000 Da/s, Polarity as 'Negative', and 'Duration' as entire time to be analyzed (min).
Set the m/z of the 'Start (Da)' and 'Stop (Da)' as the range to be scanned. Set the m/z of the 1st and 2nd precursor ions of the
target SM species of interest.
 

NOTE: To analyze multiple SM species, highlight the '-MS3' icon, right click, select 'Copy this experiment', and then put the m/z
of the 1st and 2nd precursor ions of other SM species.

4. Select the 'Advanced MS' tab, and set each parameter as follows: Scan mode as 'Profile', Step size as 0.12 (Da), Resolution Q1
and Q3 'Unit' and 'LIT', respectively, Intensity threshold as 0, Setting time as 50 (ms), Pause between mass ranges as 1.5 ms,
select 'Dynamic fill time', Q3 Entry Barrier as 8 V, and Excitation Time as 25 ms.
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5. Click the 'Edit Parameters' button in the 'MS' tab and select the 'Source/Gas' tab. Set the parameters of the curtain gas, collision
gas, ionspray voltage, temperature, ion source gas1 and gas2 as listed in Table 1. Then select the 'Compound' tab. Set the
parameters of the declustering potential, entrance potential, collision energy, excitation energy, and collision energy spread as
listed in Table 2.

6. Highlight 'Integrated Valco Valve' and select 'Position Name for Step 0' as A, and set 'B' as position for total time 5.0 min. Also set
'A' as position for total time 70.0 min.

7. Highlight 'Shimadzu LC system'. Select the 'Pump' tab and set Pumping mode as binary flow, total flow as 0.28 mL/min, and
maximum of pressure limits as 20.0 MPa. Select the 'Autosampler' tab and set the rinsing volume as 200 µL, needle Stroke as
52 mm, rinsing speed as 35 µL/s, sampling Speed as 5.0 µL/s, purge time as 25.0 min, rinse dip time as 5 s, and rinse mode as
'Before and after aspiration'.

1. In addition, enable the cooler unit, set the cooler temperature as 4 °C and the control vial needle stroke as 52 mm. Select
the 'Oven' tab, enable the oven and set the oven temperature and maximum temperature as 50 °C and 85 °C, respectively.

2. Select the 'Controller' tab and check the box 'Power on'. Select the 'Time Program' tab and set the solvent gradients as
follows: Solvents A/B at a 100/0 ratio for 5 min, program linear alterations to 80/20 over 4 min, to 35/65 over 50 min, and to
25/75 over 1 min. Afterwards, hold them at 25/75 for 10 min, then linearly to 100/0 over 4 min. Then save the method.

3. Create batch file
1. Double click the 'Build Acquisition Batch' icon, click 'Add Set', 'Add Samples', set the number of new samples, and click 'OK'.
2. Click the 'Method Editor' button and select the method to be used. If multiple methods are used in one batch file, check the

box of 'Use Multiple Methods' and select the acquisition method for each sample. Rename 'Sample Name', set the appropriate
number for 'Vial Position', and put the amount of injection volume. Then save the batch file.

4. Obtain the MS3 product ion spectra of the SM species of interest by LC-ESI-MS3 analysis
1. Select the 'Submit' tab in batch file, highlight the line of samples to be analyzed, and click the 'Submit' button.
2. Click the ''View Quene' icon, 'Equilibrate' icon, select the acquisition method to be used, set Time as 1 min, and click 'OK'.
3. Deactivate 'Reserve Instrument for Tuning' by clicking the corresponding icon. Then execute batch sequence by clicking the

'Start Sample' icon.

5. Assign each MS3 product ion spectra of the SM by comparing the mass to charge ratio (m/z) of the product ion spectra and the exact
mass of the sphingoid LCB and N-acyl moiety of interest. Determine the number of carbons and double bonds in the sphingoid LCB
and N-acyl moiety according to the corresponding product ions.

1. Confirm that the appropriate sub-project folder is selected, then double click the 'Open Data File' icon, and select the samples to
be analyzed. Drag the peak in chromatogram for each target SM species and then double click. The obtained MS3 product ion
spectra within the dragged area will be presented.

3. Quantitative analysis of the SM by LC-ESI-MS/MS
1. Set the mobile phases and HPLC column as described in step 2.1 and 2.2.1.
2. Set the parameters of the triple quadrupole and quadrupole linear ion trap mass spectrometry system for multiple reaction monitoring

(MRM) analysis as listed in Table 1 and Table 2.
1. Conduct the procedures as described in step 2.2.2.1 and 2.2.2.2.
2. Click the 'file' tab, select 'New', and select 'Acquisition Method' and 'OK'. Click the 'Mass Spec' icon and 'MS' tab. Select Scan

type as 'MRM', Polarity as 'Positive'. Set 'Duration' as the entire time to be analyzed. Set the m/z of [M+H]+ and 184 as 'Q1 Mass
(Da)' and 'Q3 Mass (Da)' of the target SM species of interest, respectively. Set 'Time' as 10 ms and 'ID' as the name of the target
SM species.

3. Select the 'Advanced MS' tab, and set each parameter as follows: Both of the resolution Q1 and Q3 as 'Unit', Intensity threshold
as 0, Setting time as 0 (ms), and Pause between mass ranges as 5 ms.

4. Click the 'Edit Parameters' button in the 'MS' tab and select the 'Source/Gas' tab. Put the parameter of curtain gas, collision
gas, ionspray voltage, temperature, ion source gas1 and gas2 as listed in Table 1. Then select the 'Compound' tab. Put the
parameters of declustering potential, entrance potential, collision energy, and collision cell exit potential as listed in Table 2.

5. Set the valve as described in step 2.2.2.6.
6. Set the LC condition as described in step 2.2.2.7. Then save the method.

3. Create the batch file as described in step 2.2.3.
4. Obtain the MRM data of each SM species by LC-ESI-MS/MS analysis as described in step 2.2.4.
5. Process the MRM data using the software for data integration and obtain the data of peak area for the extracted ion chromatogram of

each SM species.
1. Double click the software icon for data integration in quantitative analysis, click the 'Edit' tab and select User Integration Defaults.

Set Gaussian Smooth Width as 1.0 point, and click 'OK'. Click the 'Edit' tab and select 'New Results Table'. Select the sample to
be integrated, click an arrow button, and click 'Next'. Select 'Create New Method', set the name of the method, and click 'Next'.
Click 'Next' and check the box of d18:1/(D31)-16:0 SM as IS, click 'Next', and click 'Finish'.

2. Click 'Displays the peak review' and confirm that the chromatogram peaks are appropriately recognized. It should be noted
that the retention time of d18:1/(D31)-16:0 SM is usually smaller by ~ 0.3 min as compared with the one of the 34-1 SM (usually
consists of d18:1/16:0 SM).

6. Quantify each SM species according to the ratio of the peak of each SM species to the d18:1/(D31)-16:0 SM internal standard.
1. Click the 'File' tab, select 'Export', select 'Results Table', confirm the format as 'MultiQuant', columns as 'Export all columns', rows

as 'Export all rows except those explicitly hidden', and then click 'OK'.
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2. Open the exported file in the Excel software. Normalize the area of the target SM species by the area of IS (d18:1/(D31)-16:0
SM). Then multiply by the theoretical amount of the IS in the injected sample to calculate the amount of target SM species in the
injected sample.

4. Constructing the standard curve
1. Obtain the MRM data of d18:1/(D9)-18:1 SM and d18:1/(D31)-16:0 SM in the samples for constructing the standard curve by LC-ESI-

MS/MS analysis as described in step 2.3.1-2.3.4.
2. Obtain the data of the peak area of d18:1/(D9)-18:1 SM and d18:1/(D31)-16:0 SM as described in step 2.3.5.
3. Calculate the amount of d18:1/(D9)-18:1 SM in the injected sample as described in step 2.3.6.
4. Construct the trendline by setting the X-axis and Y-axis as the nominal amount and calculated amount of d18:1/(D9)-18:1 SM and

obtain the trendline formula.

5. Validating the quantitative method using Excel software
1. For validation of the method, quantify the amount of d18:1/(D9)-18:1 SM and d18:1/(D31)-16:0 SM in the QC samples by analyzing each

QC sample at least three times in 1 day, and repeat at least 3 days as described in step 2.3.1-2.3.4.
2. Obtain the peak area data and calculate the amount of d18:1/(D9)-18:1 SM in the injected sample as described in step 2.3.5 and 2.3.6.
3. According to the calibration curve obtained, calculate the amount of d18:1/(D9)-18:1 SM in the injected sample.
4. Evaluation of precision

1. Calculate the average and the standard deviation of the amount of d18:1/(D9)-18:1 SM obtained in step 2.5.3 on the dataset of
the intra-day and inter-day using Excel software.

2. The average obtained in step 2.5.4.1 is divided by the standard deviation, and expressed as %.

5. Evaluation of accuracy
1. Calculate the accuracy of each data as follows:

 

[(The calculated amount obtained in step 2.5.3.) / (Nominal amount) - 1] × 100(%)
2. Calculate the average of the absolute value of the accuracy on the dataset of the intra-day and inter-day.

Representative Results

Chemically synthesized d18:1/24:0 SM (Figure 1A) and d18:1/24:0 SM in lipid samples extracted from HeLa cells (Figure 1B) were analyzed
by LC-ESI-MS3 employing [M+HCOO]- and [M-CH3]

- as first and second precursor ions, respectively. Note that the spectrum intensity of
demethylated-sphingosylphosphorylcholine (SPC) (m/z 449) is larger than that of the SM N-acyl moiety (m/z 378). In addition, the spectrum
corresponding to [M-choline-CH3 (sphingosine-1-phosphate)]- is also useful to assign the LCB of the SM. We also confirmed that the spectrum of
the demethylated-SPC (m/z 449) is mainly produced from d18:1 SPC under the condition of our MS3 analysis (Figure 1C).

The calibration curve using two-isotopically labeled SM species was shown in Figure 2A. The trendline was obtained by applying 1/x2as the
weighting factor. The result of the residual analysis was shown in Figure 2B. Note that the residual value close to lower limit of quantitation (0.1
pmol in this present study) was smaller by applying 1/x2as the weighting factor.

The parameters of the obtained calibration curve and the result of validation were shown in Table 3. The value of the precision and accuracy
were within ± 15%, showing that the present study met the criteria as a quantitation method using LC-MS8.

The amount of each SM species in the HeLa cells was shown in Table 4. HeLa cells were grown in culture media containing 10% FBS and
harvested. d18:1/16:0 SM and d18:1/24:1 SM were the most and second most abundant SM species whose structure were determined, and
consist of 54% and 14% of total SM, respectively
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Figure 1. MS3 spectra of specific m/z signals of the SM in HeLa cells. MS3 spectra of chemically synthesized d18:1/24:0 SM (A) and
d18:1/24:0 SM in lipid samples extracted from HeLa cells (B) are shown. The results were adapted from Hama et al.6 Note that the Spectrum
intensity of the SPC is larger than that of the N-acyl moiety of SM. MS3 spectra of chemically synthesized d18:1 SPC are shown in (C) by
employing ions with identical m/z ([M+HCOO]-, m/z 499) as the 1st and 2nd precursor ions. Please click here to view a larger version of this
figure.
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Figure 2. Calibration curves of SM using two isotopically-labeled SM species. (A) The calibration curve using two-isotopically labeled SM
species (d18:1/(D9)-18:1 SM and d18:1/(D31)-16:0 SM). Calibration curves were constructed using the weighting factor = 1/x2. The results of
validation are listed in Table 3. (B) Residual analysis for the evaluation of the goodness of a constructed calibration curve. The residuals in the
calibration curve using the weighting factor = 1/x2 is smaller than the ones using the weighting factor = 1/x or 1, especially in a lower amount of
d18:1/(D9)-18:1 SM. Please click here to view a larger version of this figure.

TurboIonSpray settings

Mode Curtain Gas (psi) Collision Gas ion spray voltage
(V)

Temperature (°C) ion source gas 1
(psi)

ion source gas 2
(psi)

MS3 40 High -4500 200 40 80

MRM 40 10 5500 300 40 80

Table 1. The conditions of electrospray ion source used for both qualitative and quantitative analysis. This table was adapted from Hama
et al.6

mode polarity precursor
ion (Q1)

product
ion or 2nd
precursor
ion (Q3)

declustering
potential (V)

entrance
potential (V)

collision
energy (V)

collision
cell exit
potential (V)

collision
energy
spread (V)

Excitation
time (ms)

Speed (Da/
sec)

time (s) resolution

MRM positive [M+H]+ 184 1 10 35 12 - - - 5.364 Unit

MS3 negative [M+HCOO]- M-15 -26 -10 -40 - 0 25 10000 automatically
caluculated

Unit

Table 2. The parameters of MS3 and MRM mode in triple quadrupole and quadrupole linear ion trap mass spectrometry used for
qualitative and quantitative analysis, respectively. This table was adapted from Hama et al.6

 

Table 3. The parameters of the obtained calibration curve and the result of validation. The results were adapted from Hama et al.6
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molecular species of SM amount (pmol/mg protein)

d18:1/14:0 115.5

d16:1/16:0 115.5

d17:1/16:0 239.8

d18:2/16:0 449.9

d18:1/16:0 3355.1

d18:0/16:0 203.8

d18:1/17:0 106.3

d18:2/18:0 26.5

d20:0/16:1 94.9

d18:1/18:0 94.9

d18:2/22:0 102.3

d18:1/22:0 235

d18:1/23:1 83.3

d18:1/23:0 23.9

d18:1/24:2 286.5

d18:2/24:1 286.5

d18:1/24:1 853.2

d18:1/24:0 94.6

d18:1/25:1 12.9

Table 4. The amount of each SM species in HeLa cells. HeLa cells were grown in culture media containing 10% FBS. Cells were harvested,
and total lipid fraction was extracted by Bligh & Dyer method. The results were adapted from Hama et al.6

Discussion

In the present qualitative method, we obtained MS3 product ions of a SPC and an N-acyl moiety. It is critical to properly assign both a SPC and
an N-acyl moiety. To this end, it should be noted that other phosphorylcholine-containing molecules can also be detected as MS3 product ions.
Diacyl-phosphatidylcholine (PC) and plasmalogen-PC are abundantly present in mammalian cells, and their hydrophobicity is similar to that
of SM. Therefore, diacyl-PC and plasmalogen-PC with an isotope (usually 13C) can be theoretically detected simultaneously with SM. In our
experiments, the MS3 product ions of plasmalogen-PC were simultaneously observed in the SM analysis. It is helpful to properly select the MS3

product ions of SM to know that the spectrum intensity of the SPC is larger than that of the SM N-acyl moiety (Figure 1A and B). In contrast, the
intensity of fatty acyl-moiety is larger than (or almost the same as) that of the demethylated lysoplasmalogen-PC (data not shown).

In the present quantitative method, it is critical to precisely prepare samples for constructing the calibration curve and validating the method.
In addition, the weighting factor should be properly used to construct the calibration curve; it is useful to improve the curve fitting especially at
a low concentration. We compared the calibration curves using different weighting factors. The curve fitting at low concentration was clearly
improved by using the weighting factor = 1/x2 as compared with that using the weighting factor = 1 or 1/x (Figure 2B). The value of the precision
and accuracy should be within ± 15%. If the concentration of the QC-L is identical to the lower boundary of the standard curve (lower limit of
quantitation), it should be within ± 20%8.

We employed the Bligh & Dyer method to extract the total lipid fraction from cultured cells in this study. Other methods for lipid extraction such
as the Folch method are also useful9. It is important to extract the lipid fraction using the appropriate method according to the amount and/or
properties of the samples. The number of SM species simultaneously analyzed in each injection should not be too large in order to prevent
overloading the software for data acquisition. The scheduled MRM will be useful for quantitating a number of SM species simultaneously.

Our present method using MS3 analysis is useful to speculate the number of carbon and double bonds of LCB and N-acyl moiety of SM without
additional devices. However, other structural information such as the location of double bonds, isomer (cis or trans), and shape (straight or
branched) cannot be obtained. It is necessary to use higher energy to obtain product ions and their structural information using additional
instruments10,11,12,13. The molecular formula of the product ions corresponding to N-acyl moieties was [RCO2]

- ions that do not contain nitrogen. It
is currently unknown how the collision induced dissociation proceeds.

For MS3 analysis, it is important to adjust the parameters of collision energy (CE) and excitation time for MS3 fragmentation (ExT). A higher CE
will cause excess fragmentation and reduce the intensity of the product ion of the demethylated SM as the 2nd precursor ion. In addition, the
fragmentation pattern is significantly dependent on the ExT. Before the experiments, it is desirable to determine the appropriate condition of the
CE and ExT that maximize the intensity of the product ions of the demethylated SM, SPC, and N-acyl moiety by infusing synthetic SM dissolved
in the mobile phases.
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We used d18:1/(D9)-18:1 SM and d18:1/(D31)-16:0 SM as two isotopically-labeled SM species to construct the calibration curve. The efficiency
of ionization can vary according to the SM species and the condition of the mobile phase. Thus, if the number of SM of interest is limited, it is
desirable to prepare the isotopically-labeled SM species of interest for more accurate quantitation.

The SM structure has been determined so far according to the precursor ion and the product ion corresponding to demethylated SPC.
Furthermore, it was sometimes hampered to precisely determine the lower limit of quantitation in the presence sample matrix since the target
compounds of interest were abundantly present in the sample matrix.

The present study is useful to estimate the number of carbon and double bonds in a LCB and an N-acyl moiety based on their corresponding
product ions in MS3 experiments without additional instruments. In addition, we present a quantitative analysis method for SM using two
stable isotopically labeled SM species, which facilitates determining the range used in SM quantitation. The present method will be useful in
characterizing a variety of unique SM species in various biological samples and industrial products.
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